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The Villages Computer Club will meet at 1 p.m. Friday Jan 13th 2012 at Lake Miona Recreation Center. There will be a 
presentation by Paul Rabenold on How to set-up and use Skype to Call and See family and friends (all free).  
 
Following the presentation will be refreshments, 50/50, door prizes and a problem solving session. If you have a computer 
problem you can't resolve, fill out the problem report form found at thevillagescomputerclub.com   and bring it to the 
meeting. 
 
We will start to collect VCC membership dues this week. It will go quickly but to help bring a $5 bill and your Villages ID 
card. This will help speed things up, however we will accommodate whatever currency you have.  
 
We are looking forward to another year of great presentations, giving you excellent technical solutions and good fellowship. 
 
There will be a short survey so we can get some feedbac k from the membership about the club. See survey example . 
 
If you have any questions, email TVCC.Pres@gmail.com. 
 
Last week's meeting at La Hacienda was our first meeting of 2012 and we have a large crowd. We had lots of interest in 
Skype. There were lots of questions so many we could not get to all of them. So if you did not get your question answered 
last week come to this week's meeting and ask it. We will try to leave more time since this seems to be a popular subject. 
 
We will also have a special announcement about our auction that will take place on Jan 20th. 
 
See you at the Lake Miona meeting on Friday.  Paul 
********************************************************************************** 
  

  

  
Wrapping Text around a Graphic in Word 2007  
 
When you first insert a picture into a document, Word 2007 places it in line with the text. Sometimes, you want the  
text to wrap around the picture. When you need to change the text wrapping style, select the picture, click the Text  
Wrapping button in the Arrange group on the Format tab, and choose an option from the menu.  
The Text Wrapping button gives you several options.  

POA 

PROPERTY OWNERS' ASSOCIATION of The Villages  

E-Meeting Notice 
  

General Membership Meeting Tuesday Jan. 17, 2012 

Third Tuesday of the Month - 7:00 PM 

Laurel Manor Recreation Center 
 

Speaker: Scott Cottrell 

Director of Sumter County 

Public Works Department 

"New Signage for Roundabouts and 

New Speed Limits in The Villages" 
  

 
Presentation followed by Question & Answer Session 

Coffe and Donuts for All after the Meeting 

 
All Residents Welcome - Come and Join us 

 

Please Note:  
Our fill-able online Membership Form for 2012 is on the website. 

Click "Here" and it will take you directly to the Membership Form. 
Fill it out online, print it, and send it to the address below or 

bring to a POA Membership Meeting. 

Property Owners' Association, P.O. Box 1657, Lady Lake, FL 32158-1657 
www.poa4us.org 



 
In Line with Text is the default wrapping option in  
Word 2007 and it’s the one you’re least likely to use. It  
places the picture in line with the text. The height of the 
 line on which the picture appears is  
adjusted to match the height of the picture.  
  

  

When you choose Tight wrapping (or any other type of wrapping besides In Line with Text), the image becomes a free-floating object and is no 

longer tied to a specific position within the text. You can drag the picture anywhere you want. You can even put it right in the middle of a 

paragraph, and Word wraps the text around both sides. 

  
   
******************************************************************************************************** 

Line Spacing Changed 

Microsoft Office Word 2007 introduces a newly designed default template for creating documents.  

The new template uses fonts that were designed with readability in mind. According to a blog that was active during Word 2007 

development, "the new fonts used in Word are based on the ClearType technology that provides a crisper, more easily read display of the 

fonts on most modern monitors." Calibri is the new default font for body text, and "to complement the look of Calibri, Cambria was selected 

for use in headings." 

The default template for creating new documents in Word 2007 also uses "looser" line spacing and introduces extra space between 

paragraphs. The looser line spacing is actually only 15 percent greater than single spacing (it is not double spacing, or even 1.5 line 

spacing). Its purpose is to introduce more white space in blocks of text, which makes the text easier to read. 

Because many Word users press ENTER twice after every paragraph, the Word 2007 default settings build in that extra space. Customers 

need to press ENTER only one time to add space between paragraphs. 

In Line with Text is the default wrapping option in 

Word 2007 and it’s the one you’re least likely to use. 

It places the picture in line with the text. The height of 

the  line on which the picture appears is 

adjusted to match the height of the picture. 

  

Square Wrapping wraps the text squarely around the 

picture. 

  

Tight Wrapping causes Word 2007 

to figure out where the actual edges 

of the image are and snuggles the text 

up as close as possible. 

  

Behind Text in Word 2007 enables the text to spill 

right over the top of the picture, as if it weren’t even 

there.  

The picture appears behind the text. 

In Front of Text option places the picture on top of 

the text.  The picture might obscure some of the text. 

 

Wrap Top & Bottom option places text above and 

below the image, but doesn’t allow any text to appear 

beside the picture. 

Through Wrapping is like the tight 

option but it results in an even tighter 

fit.  If Word finds any blank spaces 

within the picture, it fills the space with text. 

Edit Wrap Points lets you design your own 

wrapping shape around the picture by dragging the 

little handles on a wrapping outline.  
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1.0 line spacing, no blank line between paragraphs 

1.15 line spacing and a blank line between paragraphs 

 Resolution 

1.    Open the document that you want to look like a Word 2003 document.  

2.    On the Home tab, in the Styles group, click Change Styles.  

 

3.    Point to Style Set, and click Word 2003.  

4.    On the Home tab, in the Styles group, click Change Styles.  

5.    Point to Fonts and under Built-in, click Office Classic.  

6.    If you want to create all documents with the Word 2003 style set and fonts, in the Styles group, click Change Styles, and then click 

Set as Default.  

All future documents will open with the Word 2003 default style set and fonts. 

 NOTE    If you want to use the updated Word 2007 formatting, switch to the Word 2007 style set and the Office font set. You can 

switch back to your custom default settings later by clicking Reset to Quick Styles from Template (in the Styles group, click Change 

Styles, point to Style Sets, and then click Reset to Quick Styles from Template). 

  
See Also 

         Adjust the spaces between lines or paragraphs 

 ******************************************************************* 

More good news about Kindle Fire 

If you join Amazon Prime ($79/yr) you not only get free shipping but free Netflix, and you get to watch Free Amazon movies 
streaming down to yoru Kindle Fire but last night I streamed down an Amazon movie free on my ROKU. 

***************************************************************** 

Video Conferencing using SKYPE and a WebCam 
  
(Or talking with the kids via phone while using a web cam) 
 One of the Voice Over Internet Provider (VOIP) you may choose to use is SKYPE. 
It can be downloaded FREE and is FREE to use.  
SKYPE is available in both PC & MAC so if one of you have a PC and the other a Mac, you'll still be able to videoconference. 
  PC  Download  of SKYPE  www.skype.com 
MAC Download of SKYPE http://www.skype.com/download/skype/macosx/    
  
Also, you may download this  SKYPE  PRESENTATION – by Jack Casto http://thevillagescomputerclub.com/Present/skype_presentation.pdf 
  
Note 1:  It is free ONLY computer to computer. That includes with or without a web cam. If folks want to use Skype to call 
telephones and or get a Skype phone # of their own to call out or receive calls, there is a fee. I believe there is an actual phone 
you can buy so you don't need to be sitting at your computer to use it. (I use Skype rarely so I am not up to date on all the 
advancements.)   
Check this page to see monthly fees for calling landlines: http://www.skype.com/allfeatures/subscriptions/?
region=uscanada#uscaSubscriptionTab 
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NOTE 2:  Apparently Skype voice works fine with dial up Internet connections. I used Yahoo's similar service several years ago to 
call my daughter in Austrailia for 4 cents/min via my dial up connection. This even though I did not have long distance service via 
my local phone company. Skype works similarly. Jack Casto 
  
*********************************************************************************************************** 

Broadband Setup from A to Z 
  
Print out all the info below and get to work...have fun!! 
  
A word of caution! It is very important that you SECURE your wireless network using WEP or WPA encryption (password). IF when out of 
town or in another place, such as local Wi-Fi,  where you must sign onto an UNSECURED network...do not, repeat do not send out any info of a 
critical nature such as credit card numbers, bank accounts, your passwords,etc.  You never know on an unsecured network who may be picking 
up your information. Also, when using an unsecured  network, you should not have your personal files set for sharing. 
  
  
1. First you must connect the Comcast or Centurylink DSL modem to your computer using the cable that came with the 
modem. The cable will plug into the ethernet port on the back of your computer and the ethernet port on the back of the modem.  
2. Next, you should have gotten a CD with the modem.  REad the instructions in the booklet about installing.  You may need to 
call Comcast to get detail instructions if you don't understand the booklet's instructions. They will walk you through the process. 
  
3. Once you have the modem connected to your computer and you're able to click the Big E (Internet Explorer) and go to web 
sites, you're ready to setup your HOME and or wireless network.  I assume since you purchased a router that you intend to setup 
for wireless and perhaps have more than one computer using the broadband either wireless or via an ethernet cable from the 
computers to the router. 
  
Below you will find instructions for setting up the HOME network and for protecting your wireless using either WEP or WPA 
encryption in your router...you didn't tell me the brand of router that you purchased. Since I use Linksys, I will give you the 
instructions for it. 
  

Basic Glossary of Terms  

Packet: Data can be broken into distinct pieces or packets and then reassembled after delivery. Computers on the Internet communicate 
via packets. 

IP address: Four numbers separated by periods, assigned to your computer. Having an IP address enables you to send and receive 
information. 
Private IP address: Also called a nonroutable address, this is an IP address that’s not generally reachable from external networks but is 
acceptable for internal communication.  

Static Address: This is an IP address you purchase from your Internet provider that does not change over time. This type of address is the 
one you would typically want or need to run a server. 

Dynamic Address: An IP address you purchase from your Internet provider that may change over time. DHCP is used to dynamically 
assign an address to your computer. 

Globally Routable IP Address: This is a “normal” IP address in the sense that any computer in the world that’s connected to the Internet 
can contact the computer having one of these IP addresses. 

DHCP (Dynamic Host Configuration Protocol): DHCP enables a computer to automatically acquire an IP address on startup when 
connected to a network. DHCP uses broadcast, so it becomes important to have only one DHCP server on a network. 

NAT (Network Address Translation): An IP sharing scheme in which one globally routable IP address is shared among several 
computers. Each of those computers is given a private, nonroutable address and the NAT device handles the translation. Most current 
home networking products use the term “router” to describe the ability to share a single IP address. 

MAC (Media Access Control) address: Each network card has a unique hardware address. You can use this address to restrict access to 
only those computers with Ethernet addresses that match a list you supply. 

Router: Routers select a path through the Internet so that a packet can reach its destination. “Router” is the term most often used by 
vendors to describe devices that share an IP address, although “network address translation device” would be more accurate in this case. 

Hub: A simple device for sharing network connectivity. When a hub receives a packet on a designated port, it replicates that data to the 
other ports. In most cases, you’d be better served with a switching hub (“switch”). 

Switch: Also called a “switching hub,” a switch reads the destination address of each packet and forwards it to the correct port. For this 
type of device, a switch is the thing to buy (as opposed to a hub). 

AP or Access Point: This is a device that shares a wired connection with wireless clients. Think of an AP as a wireless hub. 

Uplink: In satellite communication terminology, this term refers to the connection between the earth station and the satellite. On home 
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network sharing devices, it’s sometimes used to describe the connection between that device and the larger Internet (i.e., your DSL or 
cable modem). In the case of Linksys devices, the uplink port is either a standard port (for another device) or it can be used to connect 
another switch should you need more ports. 

WAN Port (Wide Area Network Port): For Linksys devices, this describes the port to connect to your DSL or cable modem in order to 
connect to the larger Internet. 

MDIX (Medium Dependent Interface Crossover): The label for the port you need to connect to the cable-modem or DSL modem. Think of 
it as the “uplink” for connection to the larger Internet. 

SSID (Service Set Identifier): Also called “network name. Client computers must supply the network name to associate with a wireless 
access point. This can be used as a simple method to help keep unwanted users off your home wireless network. 

WEP (Wired Equivalent Privacy): Encryption scheme used to protect wireless networks. Unfortunately, it is not very secure because there 
is a small device on the market that can hack your WEP code if they are close to your house. 

WPA: Encryption provides more security than WEP. 

*********************************************** 
  
SETUP HOME OR SMALL OFFICE WIRELESS NETWORK 
  

1. Install DSL or Cable modem  
2. Install Linksys or D-Link router  
3.  Plug CAT cable from modem to the router’s Internet port.  
4. Plug Ethernet  cable from computer to one of  the router’s computer ports. (Or install USB wireless adapter)  
5. Restart computer  
6. Click big E (Internet Explorer), when you are able to get online when connected directly from your computer to the broadband modem, you’re 

ready to setup your router and then connect from the modem to the router and from the router to each computer either using a wireless card in the 

computer or via an Ethernet cable plugged from the router to the computer.  
7. Next, Go to Control Panel and click Network. This will bring up the network wizard.  
8. Select to connect through Other Gateway (that’s the router).  
9. Type in a description of the Main Computer, such as JmaxWorkhorse  

10. Type in a name for the computer, such as HP6497. The name and description must be different for each computer.  
11. Type in a name for the work group, such as MSHome (All computers must be given the same work group name and do not leave a space in the 

name).  
12. Click Share Printer & Files.  
13. A message will suggest making a Network Floppy disk, put a floppy the A; drive and click Yes to make a Network Floppy. (I prefer to not use the 

floppy disk, but setup each additional computer same as setting the first one above.  Just be sure to give each computer it’s own name and 

description, but every computer must be assigned the same Workgroup name. 

  
Setup up other computers to be a part of the MSHOME.  
  
Home  Network 
  
14. Attach an Ethernet cable from router to computer’s Ethernet card or install a wireless adapters for each computer(that has no wireless card) to be 

added to the network.  
15. Put the Network Floppy disk (or cd) into next computer to be added to the network, doubleclick the file to run it, setting up the network in each 

computer. 

  
Note: If you are using XP you don't have to make the Network Floppy, just click on the Network Wizard and set each computer up. Make sure that 

your Workgroup name is EXACTLY the same on each computer.  The names and Id of each computer should be different. 
Note2: go into Linksys or D-Link or Belkin and create a WEP or WPA passcode to prevent anyone else from entering and using your network.  While 

WEP is good security, WPA encryption is even more secure( some older wireless adapters may not be able to set a WPA security). 
  
********************************************************* 

WEP Wireless security 
    Question:    I have broadband service, a Linksys Cable Modem (model BEFCMU10), and a Linksys WRT54GS wireless router. I currently have a desktop computer 

(w/USB Wireless B adapter) & two notebooks (no adapter necessary, built in wireless card and all working fine.  How can I let a visitor use my network if I have it 

secured? 
  
Answer:      Anyone visiting can have internet access by giving them the passcode/WEP key.  The code will only work for them while they are in range of that  network. 
  Question:  There seems to be a multitude of security options, (64 bit WEP vs. 128 bit WEP, MAC address filtering, WPA, etc.)  Is 128 bit WEP more secure than 64 

bit WEP?   Which should I use? 

Answer: You can use either the 64 or the 128 bit.  Sometimes the 128 makes it slower.  I suggest you try 128 and if you notice any dragging, switch it to the 64.  

Keep in mind that if you change from 128 to 64, you must set a new WEP key also.  The WPA encryption is more secure, but some older adapters can not setup  

WPA.   
 For Linksys  
1. Type into Internet Explorer's browser box 192.168.1.1 and press GO.  
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2. This will bring up the User box, type in the password as supplied in the router booklet and click OK. 
3. This will take you to the Linksys site. Now, click Wireless and then Wireless Security. 
4. The Wireless Security box should be ENABLED. 
5. The most frequently used Security Mode is WEP but WPA is more secure. 
6. The Default Key select #1. 
7. The Encryption Level and be either 64 or 128, whichever works best for you. I set mine for 64. 
8. Now, Enter a passphrase, must be at least 8 characters, some alpha,some numerals.  Example: CROW4T610 
9. Press the GENERATE button and it will fill the boxes below with numbers and letters. Your encryption key will be #1, but anyone  signing onto your wireless network 

will be required to put in the KEY.  You may be able to just put in the passphrase which was used to generate the encryption key for you, but some routers will 

require the Key that was generated, so write it down but do not store in your computers under the file name My Network Key.  
 CAUTION: if you set it for Wireless B configuration only "B" cards will be able to connect.  I would suggest setting it to "G" because then a "B" or a "G" can connect as 

long as they have the WEP key. Of course, now there is Wireless N.   Write this down somewhere where you'll be able to find it as  you may forget it.   On a few 

laptops, when I setup  the WEP,  I have found that I had to reboot it a few times to get it to work.  
*************************************************************** 
IP Address And Home Network Simplified 
  
Each computer connected to the internet is assigned an IP Address by the ISP they use.  You will select or be assigned an email address which essentially 

is a label that is placed over the IP Address to make it easier for you to remember.  The IP Address is a set of numbers that is recognized by the ISP server 

but that would be difficult for you to  remember.  When you enter your screen name, the ISP recognizes the IP Address (numbers) that belongs to that 

screen name and with the proper password allows that computer to talk to it’s computer. 
  
Now when you set up a home network, a little more is involved.  You’ve now plugged a ROUTER into the modem and sits between the ISP and the other 

computers connected to the router….the total being,  the network. 
  
During setup of the router using what’s called DHCP (Dynamic Host Configuration Preotocol), it is the Router that asks the ISP for an IP address.  The 

ISP assigns that Router an IP address. Now when you connect your 1st computer to the router, that computer must ask the router for an IP address so it 
can connect through the router to the ISP.  The router assigns an IP address to each computer…all the IP addresses assigned to various computers  will all 

begin with 192.168… …. Which indicates a local network.   
  
When you sign onto your computer that is connected to the router that is connected to your DSL or Cable modem it goes something like this: 
  
Computer to router…says, I am IP address 192.168…. ….please get me www.google.com  The router recognizes that IP address as the one it assigned. 
  
The router in turn…signals the ISP via the modem … and says I am IP address 205.188…( incomplete to protect privacy of IP address owner) ...please 

get me www.google.com  
  
To the internet it appears that the router is making the request and it recognizes the IP address as the one which it assigned to that router, so it says ok…

and connects to www.google.com as requested and now computer 192.168.xxx.xxx has google.com appear on it’s screen. 
  
To see what your particular IP address is,  click START…RUN and type in CMD (if using win XP.  Type in COMMAND if using pre-XP windows). 

Click OK 
  
The MS-DOS screen will appear. At the blinking cursor type in ipconfig and press ENTER 
  
You will get something that looks like this: 
Connection-specific DNS Suffix 
IP Address……………………………….192.168.1.106 
Subnet Mask…………………………….255.255.255.0 
Default Gateway………………………..192.168.1.1 
  
The IP address is the one assigned to your computer by the router. 
  
To see the IP addresses assigned by the router to all the computers connected to the router, type in ipconfig/all and press ENTER 
Type Exit to close the screen and return to windows. 
  
Now, in your browser box type http://www.whatismyip.com  and press GO 
You’ll get a screen that says YOUR IP ADDRESS IS 206.124…..(incomplete to protect privacy of IP address owner) 
  
This is the IP address assigned to your Router.  Regardless of what your particular IP address is for your particular computer, on the internet your 

computer appears to be the IP address of your router.  This is the reason that the router acts a bit like a firewall and helps to protect your computer from 

hackers. 
  
To see if you can communicate with a particular computer, click START…RUN and type in CMD or COMMAND if using pre-XP windows. 
Type Ping (and the name of the other computer) press ENTER. 
  
IF you can communicate, you will get the message x number of packets sent (number of packets of data sent from your computer;  then  x number of 

packets received(from the other computer replying to your ping).  IF 0packets received…the other computer is  not communicating with your computer.  
  
If you cannot get an answer when pinging the Name of the computers in your network, try pinging their IP address. IF the IP address responds to the ping, 

but the name doesn’t, it usually means a network software failure or just that you failed to put in the correct Name you assigned to that particular 

computer. 
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You may need to turn off your firewall to ping your own computers. It may be blocking entrance to them. 
  
To ping your own computer to see if your network software is functioning.  Type ping 127.0.0.1  which is the standard loopback address. If your software 

is working correctly, you should get x packets sent, x packets received meaning that communication is good.  IF 0 packets returned, something is wrong 

with the TCP/IP installation on the computer from which you just pinged 127.0.0.1.  
  
If you are using Wireless technology you MUST secure it via your Router’s Security program.  This is usually done by setting a WEP or a WPA 

passcode. 
  
*************************************************************************************************************************** 

Connect to an Available Wireless Network Using Win 7 

When you connect your computer to a network by using an Ethernet cable, Win 7 automatically creates the network 
connection. To connect to a wireless network for the first time, YOU need to make the connection. 

Connect to an Available Wireless Network 

1. In the notification area look for either a single monitor screen or a stack of reeds toy. This will be the icon for the wireless 
connection. Click that icon to open the wireless network box where there will be a list of wireless networks that are 
available.  If the network says Secured, it means you must enter a wep or wpa code before you can connect. 

2. There may also be a box to click to show Available Wireless Networks. you should recognize your own wireless network 
since you set it up. 

3. Click the wireless network to which you wish to connect, then click the Connect button. If necessary enter the WEP or 
WPA password.  

4. In Win 7 each network profile includes these settings: 

          a. Network discovery - can the computer see and be seen by other computers connected to the same network. 

          b. File and printer sharing - shows if network users can access files and printers you have shared. 

          c. Public folder sharing - shows if network users can access files stored in the Public folders in your computer. 

          d. Media streaming - shows if network users can access music, videos and pictures stored in your media library. 

          e. File sharing - shows the security requirements for devices that connect to your computer's file sharing connections. 

          f. Password-protected sharing - shows if files are available to any network user or only to users with user accounts in 
your computer. 

          g. HomeGroup connections - shows if only those with User Accounts can be joined to your homegroup.  

Note: Network connection types and homegroups may not be available on a computer running an earlier version of 
Windows. 

***********************************************************************************  
  

  
A Message re renewal of Florida Drivers License 
  
The license bureau will send you a postcard with the documents required for renewal. 
  
1) Your birth certificate or passport. 
  
2) Your social security card. 
  
3) Two documents showing your address on them.      I brought a bank statement, and the VCDD statement. 
  
.If you are a veteran, you can have a V placed on your license, but you must bring your DD214 form. 
  
All these documents will be scanned. 
  
You must pass a vision exam. If not, a statement from your eye doctor will be required 
  
The License Bureau is in the Tax Collector's office in Spruce Creek. Next to the old  " Bargains and Treasures " building.  
Across from Wal-Mart on 27/441. 
  
The cost is $54.25. They do not accept Visa Cards. I used a Discover Card .Cash is accepted. 
  
Gene Kwasny 
*************************************************************************************************************** 

Page 7 of 8

Thursday, January 12, 2012 AOL: JMAXPJP2



  

Thankful Dogs. 

Please turn on your sound. 

http://www.dogwork.com/prybrme8/ 

******************************************************************************* 

  

JmaxJmaxJmaxJmax  

Jmax's Website   http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info about the computer you're using, if you know 
it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. 
To send an Ad, place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  
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